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Abstract— The art of Kantanagar Temple in Bangladesh ancient history is the most powerful combination of architecture & sculptures 

which were created from 1704 to 1752 A.D. [1]. The doors, windows, pillars, ceilings, and walls were adorned with the terracotta design. 

Kantanagar Temple is a unique example of the temple architecture in the sub-continent because of the finer details of reprieves. It was 

originally constructed under Maharaja Prannath & his adopted son Ramnath renowned Jamindars of Dinajpur, Bangladesh [2]. In this 

research, we try to find out our cultural significance through technology which will help us promote our cultural heritage & its history. I make 

an overview of the state-of-the-art by Illustrator Graphics Suite CS6 in the modification process of selected motifs and in the color 

experiences, clothing design, and simulation. Through a wide range of drawing tools & special effects that have been developed. This 

paper investigates a new direction in the design through using Terracotta plaques which represent Geometric motifs, mythological scenes 

from the Ramayana & the Mahabharata, social scenes & favorite’s pastime & the author created a fashion collection inspired from the 

design which can be used to ready -to-wear market. 
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——————————   ◆   —————————— 

1 INTRODUCTION

 he Civilization of Bangladesh is a hundred years old. 
Once upon a time in Bangla as the richest region of the 
Indian subcontinent. Her deep-rooted heritage is amply 

reflected in her architecture, literature, dance, drama, music 
and painting and also in people’s lifestyle. Heritage is consid-
ered to be the best expression of the cultural identity and the 
cultural character of a nation. Heritage includes numerous 
cultural, artistic and intellectual forms inherited from the early 
and recent past of a nation. In the other hand clothes repre-
sents the culture of a country & it express our personal & so-
cial relationships linked how we live and see ourselves within 
society and also it is considered as one of the world’s largest 
industry. It can be an opportunity to bring up our cultural 
heritage through clothing using technology. So, the challenge 
is to find out the way how we can do it. The main objective of 
this research study is to find out the way of promoting our 
heritage through clothing.   

2 1.1 BACKGROUND OF THE RESEARCH 

Kantoji Temple at Kantanagar is a late-medieval Hindu temple 
in Dinajpur District, Bangladesh [3]. (Ghosh, 2005) It was built 
by Maharaja Pran Nath; its construction started in 1702 and  

 Fig. 1. Full view of kantoji temple 
ended in 1752, during the reign of his son Maharaja Ramnath 
[1]. It is one of the best examples of terracotta architecture in 
Bangladesh. The Terracotta Temples of Bengal are famous for 
the terracotta motifs used for ornamentation on the temple 
walls ‘as one of the most original and unique expressions of 
decorative temple art in the late medieval period of Bengal’ [4] 
. Figurative sculptures of popular gods and goddesses, human 
in their dancing postures, conjugal postures, floral decora-
tions, animal figures, etc. were generally used as themes for 
ornamentation. Along with these, activities of social lives, reli-
gious cult practices, scenes from the epics and wars were also 
depicted in the terracotta motifs. The Terracotta Temples of 
Bengal such as kantoji temple stands as the epitome of culmi-
nation of various influencing factors – be it the geographical, 
geological, structural, social or political factors. 
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Fig. 2. Terracotta designs of human in their dancing pos-
tures, conjugal postures, floral decorations, animal figures  

1.2 Nativity 

1.2.1. Terracotta Plaques: 

The meaning of Terracotta is “baked earth “it’s a Latin word. 
Terracotta is a type of stoneware, which is ceramic based on 
unglazed or glazed clay where the fired body is absorbent. In 
earthenware, Terracotta is the term usually used for sculpture 
made, and also for various functional uses including flower 
pots, water, and wastewater pipes, tiles which used in roof, 
bricks, and surface embellishment in building construction. 
Most terracotta is brownish orange color &the term is also 
used to refer to the natural, which varies considerably.  

1.2.2. Computer-aided design (CAD) and art 

Computer aided drafting is known as Cad (computer aided 
design). Usually it uses of computer systems to promote in the 
modification, analysis, creation or optimization of a design. 
The process of creating a technical drawing with the use of 
computer software defines computer-aided design. Electronic 
files often in the form of CAD output for machining opera-
tions or print. Cad software uses either vector-based graphics 
or may also produce raster graphics Vector based graphics 
describes the objects of traditional drafting & raster graphics 
shows the overall appearance of designed objects. The output 
of CAD delivers information such as materials, dimensions, 
processes, and tolerances, according to application-specific 
resolutions which uses in the manual drafting of technical & 
engineering drawings. . To design curves and figures in two-
dimensional (2D) space; or surfaces, curves, and solids in 
three-dimensional space CAD may be used. In many applica-
tions, including automotive, shipbuilding, and aerospace in-
dustries, industrial and architectural design, prosthetics, and 
many more design CAD is widely used as an industrial art. To 
create digital content CAD is also widely used. 

CAD consents greater chance for the production of many changes for the same design, which can be use and

improve or save it as a library of designs as well as this system permits for greater accuracy and tractability in the 

design process. Drawing realistic bodies, hair, faces & designing convincing clothing is a crucial element.  

2  Significance of Research 
This paper intends to use CAD and the technique to recognize 
fashion trends of 2D garments by using terracotta motif of kantoji 
temple on the surface of the fabric. Next study the relationship be-
tween the parameters of the 2D garment prototype and different 
garment styles. Based on the relationship, the processes and com-

peers of rules for transferring style requirements to the parameter 
values of the garment prototype are developed. As such, the 
knowledge base can be constructed, and the quick design system of 
garment style is built. Various garment styles can be designed 
spontaneously to satisfy several style requirements using the sys-
tem.  

5  MATERIALS 

3.1 Adobe Illustrator CS6 

In clothing enterprises computer aided garment design system 
has been widely used & it has improved production efficiency 
significantly. The process of operating the system is interactive 
whereas most of the systems are developed for 2D garment 
design. Instead of ruler & scissors designers are used mouse & 
light pen which helps to increase work efficiently by using this 
system but the process of designing is the same conventional 
process. Such kind of garment CAD system cannot please the 
garment initiatives because of the development of clothing 
industry. “To solve this problem, many researchers have been 
focusing on & have developed different garment design visu-
alization & 2D style intelligent design, respectively” [5]. As for 
2D garment intelligent CAD system, genetic programming 
however adobe illustrator CS6 is a spontaneous and adaptable 
graphics application for creating high-quality vector illustra-
tions, and designs, a wide range of drawing tools and special 
effects we can choose to create realistic, photo-quality illustra-
tions, all by hand, it also provisions pen tablet technology, 
which makes the experience of drawing by hand smooth and 
instinctive. We can create splendid illustrations by using tools. 
Illustrator CS6 helps to create & modify shapes by providing a 
variety of drawing tools. The most time-consuming task in 
illustration is drawing lines. To trace the sketch several meth-
ods can be used. We can effectively trace it by using image 
trace if the original sketch is detailed enough. Alternatively, 
rectangle & ellipse tool is normally used to create simple 
shapes or by using pen tools can manually draw lines & 
curves. One can edit and fine-tune their shape by using the 
Shape tool after drawing the curves. By using rotating, scaling 
& reflecting one can modify whole objects. 

3.1.1New tools in Adobe Illustrator CS6: 
Over the years the application has been given some quite re-
markable features - from the Gradient Mesh in the 1998 release 
of version 8 to multiple art boards in CS4 and the Perspective 
Grid in CS5 (which Adobe ported across from FreeHand, the 
tool it bought from Macromedia and then phased out), it is a 
behemoth of an application, whether you want to create pho-
torealistic illustrations or slick logos.  Adobe Illustrator CS6, a 
facelift, some speed improvements, a few tweaks and one ma-
jor addition that illustrators and designers in particular will 
love are all on the agenda.  

3.1.1.1Image Trace in Illustrator CS6 

Illustrator is a little miscalculated sometimes. And it's proba-
bly because of its ability to trace raster images to create vector 
graphics. Adobe Illustrator CS6 sees the end of Live Trace, 
bringing in a new tracing tool and engine housed in the Image 
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Trace panel. When one place a raster image in Adobe Illustra-
tor CS6 (JPEG, TIFF and so on) can access Image Trace one of 
two ways [6]. By the presets in the Control Panel (can create 
own presets - more on this in a bit) or by using the compre-
hensive Image Trace panel under Window>Image Trace. 
There are five options that run across the top of the panel, 
which are separate to the presets - think of them as starting 
points. These are: Auto-Color, High Color, Low Color, Grey 
scale, Black and White and Outline. Once you've applied a 
starting point, the main slider within the panel changes con-
textually, giving further control. 

3.1.1.2 Add more colors  
It gives you options for adding more colors in the 'Color' start-
ing points, Greys in   mode and Threshold in Black and White 
and Outline modes [6]. You can choose different views as 
you're tracing: Tracing Result, which shows the final trace; 
Tracing Result with Outlines, showing paths; Outlines; Out-
lines with Source Image; and Source Image. At any time press 
and hold the small eye next to this dropdown to view the 
source image.  

3.1.1.3 Guassian Blur Effect 

 Another feature of note is improved, the Guassian Blur. In 
Adobe Illustrator CS6 you preview your blur on the art board 
- if the Preview box is checked as you ramp up the slider your 
selected object blurs in real time. And once again, it's fast. 

3.1.1.4 Pattern Creation tools: 
Usually, an upgrade has a killer feature. Something that users 
just cannot imagine not having. If there's one feature that fits 
this mold it's Adobe Illustrator CS6's new Pattern Creation 
tools. Patterns are something designers and illustrators create 
in Illustrator on an almost daily basis. And this changes things 
in a big way. Creating patterns pre-CS6 was a little clunky. 
Create your objects, go to Edit>Define Pattern and then apply 
that swatch to your object. If you want to edit the pattern it 
was difficult, and lining up a tiled repeat using a pattern 
swatch was often frustrating. CS6 changes this. 

3.1.1.5 Pattern Options panel 

Here's a typical workflow to show you how easy it is to create 
repeat patterns. First, open or draw your objects, select them 
and then go to Object>Pattern>Make. Your object is immedi-
ately repeated according to the settings in the new Pattern 
Options panel. Your pattern swatch is added to the Swatches 
panel but you can edit in Pattern Creation Mode until you're 
happy, finalizing the swatch by hitting done. We'll go back to 
the Swatches panel in a moment. The Pattern Options panel 
gives you a huge amount of control over your patterns. You 
can change the tile type (even interactively tweaking the tiling 
using the Pattern Tile tool - accessed from the panel), spacing, 
copies and more depending on the preset you've chosen. A 
very handy option is being able to dim copies of repeats with-
in your pattern as you're working on it - so you know you're 
working on the original object. A slider and percentage field 
let you edit the amount your repeats dim.  

3.2 Methods of Design Works 

These works are to develop a new influential area of Kantoji 
Mondir which clothing design can express by introducing the 
formativeness of constructionist’s sculpture, which was a 
foundation of arts, into fashion and to realize it to be visual 
modeling. The main method applied in this study was the re-
search of relevant documents and design work in the field. A 
visual and connectional image was conducted by publications, 
articles, and magazines. Clothing design work was formed out 
of redefining the elements of constructivism by investigating 
its visual images and established a concrete design plan for the 
study. Primarily, data of design Kantojir terracotta designs 
including constructivism were collected and categorized to be 
analyzed formatively after background and concept of con-
structions were arranged and then constructionist of Kantojir 
terracotta to design applied to clothes formative embodiment 
were analyzed. In order to decide the clothing image, the con 

      Fig. 3. Terracotta designs outside the temple 
cept and properties of clothing design are arranged. The pat-
terns and decoration from ancient time to the present time 
were studied historically and cases of clothing design shown 
in modern fashion were analyzed, centered on collections. The 
design works drawn into the construct shapes, repetitive as in 
fractals. The silhouettes were precisely draped, and drafted, 
for the most natural function of a garment, much in the same 
way a snail builds a shell. The colors are subdued and tonal, 
but not flat –they are soft with energy. The line consists of 
pieces that allow for stacking and layering and also mixing of 
textures and silhouettes, it also can combine very well other 
lines. The pieces are all very intentionally finished, from inside 
and out. I tried to sift some samples from the patterns on the 
walls of the temple as the following: The intelligent system is 
easy to learn and operate so that even the general user without 
the professional knowledge and skills can make it work effi-
ciently. The new system combines the fashion design system 
with a pattern design system; therefore, the conception of the 
designer can be retained during the design process. The new 
system can greatly shorten the time required for the design 
and improve design efficiency. Also, it makes the expenditure 
for employing a professional designer unnecessary.  The di-
vinity of the terracotta design is associated with the tales of 

1731

IJSER

http://www.ijser.org/


International Journal of Scientific & Engineering Research, Volume 10, Issue 9, September-2019  
ISSN 2229-5518 

IJSER © 2019 

http://www.ijser.org  

Mahabharata and Ramayana, the exploits of Krishna and his 
spirituality, and a series of extremely fascinating contempo-
rary social scenes depicting the favorite leisure time of the 
aristocrat class. There are also depictions of animated hunting 
scenes of wild games, royal processions of elephants, horses, 
camels, and dainty ox-carts of the nobility with their retainers 
in Mughal dress and arms. The richly caparisoned majestic 
elephants and splendid stallions, their chariot and harness are 
vividly delineated. There are also curving of the zamindars 
who are seen squatting in their gilded palanquins puffing 
from luxurious hukkas with long sinuous pipes. Mythological 
scenes are also depicted, such as the nativity of Krishna, the 
demon King Kangsa, successive attempts to kill the infant 
Krishna; Krishna's killing of the Putana ogress and the Bakas-
ura or crane-demon [3]. The detailing of the Hindu scripture 
in its clay and crafted forms are explicitly striking. The temple 
consists of deities which depict the astonishing sense of reali 

Fig 4. Application of different types of tools tocreate motifs 
ty, the endless panels of terracotta art embellishing & and or-
namenting the wall surface of the Kantaji Mandir, giving it a 
life and vitality of their own and are deeply imbued with the 
spirit nourished for thousand years on the silt-laden soil of 
Bangladesh [1].  From below image some terracotta designs 
motif is selected which were redrawn by computer graphic 
program (Illustrator).   

Fig. 5. Concept Board 

Fig. 6. Mood Board 
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3.2.1 Development of others motif using Adobe Illustrator 

tools CS6 

Fig. 7. Development of different motifs using Adobe Illustrator 
CS6 inspired from temple's terracotta design & implication-
Figure axis labels are often a source of confusion. 

3.3 Implementation 

Fig. 8. Implementation of motifs into dress (Range Plan) 

4  Result & Discussion  
Terracotta design is very popular in art sculpture but a de-
signer who designs clothes can be an observer and creative 
thinker as well as a good listener, a careful interpreter and a 
skilled craftsperson who takes his/her inspiration from any-
thing. He must understand style, composition, balance, aes-
thetics and human emotions and also understand the vision 
and the psychology of perception. Using elements of art, the 
designer must learn to think sense and generate with his heart. 

The designer needs a new, fresh, innovative spark for creating 
any design. From inspiration, all these design ideas come. The 
inspiration for a design can be found everywhere. The aesthet-
ic beauty of kantoji temple is asymmetrical order, geometrical 
structure, photo mixture techniques, and colorist implications. 
The asymmetrical order emphasizes rhythm and movement 
formed by imbalance and asymmetry, creating a dynamic 
rhythmical sense and expanding the spatial concept. Geomet-
rical structures express features of non-objective forms and 
artificial, modern forms. A rhythmical sense is presented from 
geometrical structures of figure factors such as straight lines, 
oblique lines, circles, and squares. Kantoji temple’s terracotta 
design has a new visual language that tells stories of Ramaya-
na & the Mahabharata, the contemporary social scenes & fa-
vorite’s pastime. Visual characteristics like clarity and visibil-
ity of colors were reasonably used to express intended themes 
or contents. Kantoji temple architecture can be an inspiration 
for a fashion designer. It may seem a little surprising to use an 
architectural temple as an inspiration for fashion design, but 
all examples of architecture, whether traditional or contempo-
rary, can cause a creative spark to the designer. The fashion of 
constructivism which received influence from this constructiv-
ism include the trend of absolutism, productions designs, Kan-
toji temple expression of simplicity, applications of textile de-
signs and motives, considering its characteristics such as geo-
graphical organization and abstract forms, expressions of dy-
namics and movement, use of clear colors, and simplified pat-
terns. The trend of despotism stands for pure geometrical ab-
stracts. It expressed cubism and nonobjective ground configu-
ration by basic forms with squares as the factor and accompa-
nied by circles of fashion designs of the production of Kantoji 
temple. As an art trend directly participating in productive 
activities, it rejected industrial materials based on realism and 
expressed abstract, dynamic beauty with a physical sense of 
proportion. It showed a new and equal value in clothes 
through the human body, as well as articulating clothes as a 
subject which powerfully presented a social sense of belong-
ing by directly upsetting the wearer’s insolence. Characteris-
tics of simplicity trend designs have short, strict and simple 
formative lines as main factors and pursue simplification, min-
iaturization of detailed decorations. Especially a representa-
tive constructionist used a ruler and compass for comparison 
of geometrical patterns and colors, and to display structures of 
clothes and geometrical shapes. This formative feature de-
signed productive working clothes called overalls. The top 
part could be separated as a uniform jacket while the pants 
were like a sailor’s trousers with its needlework being com-
pleted by using textiles and leather used geometrical motives, 
collage, photograph montage, and motives with a theme. De-
signs were finished with various arrangements. As for deter-
minative characteristics of clothes, forms highlighting practi-
cality and convenience were designed and geometrical consti-
tution rules were highlighted. The sketches that they have 
drawn guided them in deciding which details are to be used 
and which are to be eliminated of Kantoji temple. Finally, I 
have united the basic elements into their fashion designs. In 
these designs inspired by architecture, you can discover inter-
esting textures, glamorous colors and strong design features 
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that reflect their source and are also concepts in their own 
style. In the following paper, the examples from these designs 
will be given and architectural interactions will be discussed. 
Geometrical organization and architectural images were 
stressed and simple, concise works based on geometrical mo-
tives with two-dimensional features that could go into mass 
production were designed. A new form of emphasizing func-
tion and purpose was proposed and a special production 
working clothes based on reductionism were made. Funiculars 
were used regularly and colors with strong contrast were ap-
plied as trimming. Gradual effects of colors were articulated to 
put stress on diversity. Rectangular or straight silhouettes 
were used for clothing design which can be easily manufac-
tured and supplied for the public. 

5  CONCLUSION 
In this paper, we constructed the prototype of a garment with 
the designer working in art surface patches and expressed 
these relations into arithmetic and generated rules. By setting 
up the knowledge base with object-oriented technology and 
illation mechanism, we accomplished garment intelligent de-
sign; we have proposed a novel solution for the design of vir-
tual garments of Kantoji temple terracotta design. An initial 
rough geometry is approximated by a piecewise developable 
surface. The folds that appear on a garment worn by a charac-
ter are added procedurally, taking advantage of the well-
studied buckling properties of the fabric. Since we compute 
the corresponding 2D sewing patterns, distortion-free texture 
mapping becomes straightforward, and realistic replicas of the 
designed garments can be sewn. My methods for developable 
approximation and for generating cloth folds can be used in 
several other contexts of Kantoji temple. In particular, the de-
velopable approximation method can be used for a variety of 
engineering applications requiring developable surfaces, such 
as forming or forging. our practical method for fold generation 
can be applied to generate folds on any input mesh represent-
ing a garment. This study is aimed at reviewing the unique 
formative aesthetics of constructivism for the creation of mod-
ern clothing design of Kantoji temple terracotta art. Construc-
tivism can be regarded as bold plan delineation, a reciprocal 
symmetry, a geometrical whole line, the graphics formative 
material, and the functional and basic material contrast to-
gether with color contrast, which are the self-conscious ex-
pressions for a new sense of life. Geometric, spatial and con-
structional and kinetic form principles were applied as con-
structionist sculptures were introduced to shape visually im-
age. The materials of works soft woven fabric. They were used 
to express such geometric and space constructional as a circle, 
square, triangle and cube. It was verified that they were them-
selves harmonized with clothing, they were shaped formative-
ly and various materials were available in Kantoji Temple’s 
terracotta. As a result, the expressive clothing design could be 
expanded as three-dimensional patterns composing space and 
a side was expressed by organizing the lines of the body. This 
works overcame such a problem by creating the conceptual 
view of the constructivism. It objectively created a design with 
nature as a subject, using these objectified elements in a design 
process. The method could be used in two different ways to-

ward this goal. The 2d patterns we generate can be used by a 
cloth animation system to compute the rest lengths of the 
springs that model the cloth material. Thus, the garments we 
design can be animated using standard techniques. Another 
option would be to take advantage of our procedural model-
ing of fabric folds during an animation. Then, only the control 
mesh would need to be animated using physically-based sim-
ulation, while fine details such as folds, costly to simulate 
since they are caused by stiff, buckling phenomena, would be 
added procedurally at no cost prior to rendering. We plan to 
explore this approach in the near future. Another possible ap-
plication of our work is the prototyping of real garments. A 
fashion designer could use our sketching system to quickly 
sketch some clothing, automatically get different views of the 
garment, edit the model as necessary, and finally print the 
corresponding 2D patterns. 
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